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Editorial

W

elcome to the spring issue of the LRG
Newsletter and my debut as its editor. Before
leaping into this issue, I would like to say a big
“thank you” to Betti on behalf of all readers. Betti
expertly edited the Newsletter for five years and I
hope that I can display the same level of dedication
and aptitude. Thank you Betti!
The arrival of spring heralds a busy programme of
events for us all. The upcoming ITI Conference on
“Sustainability in Translation” on 16 and 17 May is
the ‘must-attend’ event of the year. We hope to see a

good turnout from LRG members. And don’t forget
that there will also be a networking event at the Old
Star pub on the Friday evening before the
conference. And then there’s the conference talk and
networking event in June and the annual LRG pub
crawl in July to look forward to.
This issue also features a review of events from
earlier this year and an article about Excel tips and
tricks, which will be useful to many of us, I’m sure.
I hope that you enjoy the Newsletter.
Rosemary Black

Forthcoming LRG Events
Friday, 15 May 2009
from 6.30pm

Tuesday, 23 June 2009
6.30 for 7.00pm

Pre-Conference gathering of ITI
Networks and Regional Groups

Conference talk and
networking event

at the Old Star pub, 66 Broadway, London SW1H
0DB, opposite the Broadway exit of St James’s tube
station

at the Devereux pub, 20 Devereux Court, off The
Strand or Essex Street, London WC2R 3JJ.
Nearest tube: Temple (District and Circle lines),
buses to The Strand.

This is an opportunity for members of ITI Regional
Groups and Networks to meet informally for supper
and drinks on the eve of the ITI Conference. It will
be held at The Old Star pub, opposite St James’s
Park underground station in London.
Anna George, who is a member of the Conference
Committee and also of GerNet, has kindly arranged
for us to have exclusive use of the upstairs room at
this very nice pub. It does rather good food and is
conveniently located close to the park and the
conference venue.
Menus start at £12 for a 2-course meal. Two tables
have been reserved for the LRG.
If you would like a place, please contact Anna George
immediately at anna@agtrans.co.uk and say that you are
booking for the LRG table.

Rhona Desmond – one of the recipients of the two
LRG conference grants – will give a short
presentation about the ITI Conference. This will be
followed by questions and an informal networking
session.
The event is free for LRG members (£3 for non-members).
To book, please contact our Events Secretary, Fiona
Franks, at ffranks01@googlemail.com

Thursday, 16 July 2009
from 6pm

The annual LRG Pub Crawl
this year’s location: pubs in the Belgravia area
The annual LRG pub crawl will take place in
Belgravia this year. Please feel free to arrive from
6pm onwards for drinks and socialising with other
LRG members in an informal setting. Details of the
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pubs visited will be announced by email to all LRG
members. For now, please make sure you have the
date marked in your diaries!

- website dos and don’ts

Contact: Julia ten Elsen at j_tenelsen@yahoo.com

- assertiveness and negotiation skills.

Saturday, 12 September 2009
10.30am to 4.30pm

Speakers confirmed so far include Heidi Kerschl
MITI, Keren Lerner of Top Left Design and Laurence
Blume (freelancecopywriter.co.uk).

Marketing Workshop
Venue: University of Westminster,
309 Regent Street (nearest tube:
Oxford Circus)
An all-day event with talks and workshops on a
variety of marketing-related subjects, including:

- a practical workshop on how to write good
promotional copy

Cost for the full day is £25 for LRG members, £35 for
non-LRG-members. Refreshments and a light lunch are
included in the cost. Advance booking is required.
For further details please contact Betti Moser at
betti@apriltext.co.uk.

- marketing yourself as a freelance translator or
interpreter

Review of LRG Events
Pension planning for freelance and
staff translators and interpreters –
12 February 2009
This presentation on pension planning for
translators and interpreters, organised by Pamela
Mayorcas, was held on a cold, snowy evening in
early February at the Devereux pub near the Royal
Courts of Justice, which provided a warm and
welcome relief from the weather outside.
The presentation was given by Martin Bunker and
Paul Hays from the Pensions Advisory Service
(TPAS), a well-respected, independent not-for-profit
organisation that has been providing information
and advice to the general public since 1983.
The presentation provided a clear overview of
pension and retirement considerations, and
answered questions such as:
• How much income will I need when I retire?
• What State benefits will I receive?
• What will my current and previous pension plans
provide?
• What if I retire early?
• What other types of saving are available to me?
The state pension was introduced by David Lloyd
George one hundred years ago when many people
did not live long beyond retirement age, but people
can now expect to live well into their eighties and
should make some private provision for retirement.
According to TPAS, however, over a third of selfemployed people do not put any money away into a
private pension.

The maximum state pension provides an income of
under £5,000 per year, which is certainly not going
to allow you to travel the world once you’ve given
up work! If you have something slightly grander in
mind for your retirement – for example, an income
of around half the income you enjoyed when you
were working – you only need to contribute
approximately 10% of your income to a private
pension fund if you start contributing in your
twenties, 16% of your income if you start in your
thirties, and 27% if you start in your forties. I don’t
think that many of us will need more of an incentive
to start early!
During the presentation, Martin gave us a few facts
of particular relevance to translators and
interpreters. First, self-employed people can benefit
from contributing to a ‘stakeholder pension’, which
is a type of low-charge private pension scheme that
must satisfy a number of minimum government
standards to ensure that it offers value for money
and flexibility. More information can be found on
TPAS’s stakeholder pension website:
www.stakeholderhelpline.org.uk/whatis.asp.
Second, translators and interpreters can take
advantage of state pension benefits in other EEA
countries. This information was particularly useful
to our group as it included people from Greece,
France, Germany and Poland among other
countries. Each EEA country calculates pension
benefits based on contributions paid to their social
security scheme, so if you have spent time working
and paying tax in another EEA country, you can still
receive state benefits on retirement.
Third, Martin explained that even in today’s
uncertain economic climate, it is still worth
investing in a pension, despite the fact that your
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investments can go both up and down. He
encouraged us to consider the difference between
risk and volatility: risk is the price you are willing to
pay to achieve a desired outcome, whereas volatility
is the variations in value along the way. Your
pension fund could lose money in the short term
during a recession, but if you still have plenty of
time until retirement, your investments will
probably recover and now could even turn out to be
the right time to invest, while stock market prices
are low.
Overall, the evening was motivational and
enjoyable, and helped to demystify pensions for the
entire group, regardless of age and nationality. It
was definitely worth coming out in the snow.
Rosemary Black

Open Access modules at Westminster
University and MemoQ presentation
– 16 March 2009
Ann Pattison and Havila Peck from the University
of Westminster opened the evening at the Devereux
Pub and talked about the Open Access Modules
now available at the University of Westminster.
They include: Economics & Finance; Computer
Assisted Translation (CAT); Principles of Science &
Technology; and French Editing Skills.
Philippe Galinier had written an interesting article
on the Science & Technology module in the
January/February ITI Bulletin and spoke about it
during the evening. He recently completed the
module and found it very worthwhile.
The University of Westminster is considering
offering training in translation from a cognate
language next year, involving half a module spread
over a year. Translators working from French to
English could, for example, learn Spanish or
Romanian as a cognate. It was also mentioned that
there is a shortage of Romanian to English
translators and that it should be possible for
translators currently working from Romance
languages into English to gain another source
language after approximately one year.
We were also given an interesting insight into the
CAT module by Jane Jones who gave a very
informative presentation on her experience of it.
SDL Trados is apparently available at the discounted
rate of £50 to those who register for this module,
and the SDL Certificate can also be taken. The
module costs £425 for 12 weeks (2 hours per week +
private study).
The second half of the evening was devoted to the
relatively new translation memory package MemoQ
which was demonstrated by the software developer,
Istvan Lengl. MemoQ is said to be the most

successful newcomer to the market. It includes
Concordance and Pretranslate, there is no restriction
on the number of translation memories that can be
used and it is fully compatible with Trados. Comtec
Translations, represented by Sophie and Don Howe,
have used it for a couple of projects and gave some
very positive feedback. It seems user-friendly with
full networking support, and I think that it is
definitely worth considering.
I found the evening very interesting and stimulating
with plenty of useful information to digest.
Maureen Thomas

The Specialisation Debate –
23 April 2009
Increasingly, freelance translators and interpreters
are advised that specialisation is the key to success
in a highly competitive marketplace. This applies in
particular to translators and interpreters working
into or out of major European languages who have
to compete with many other colleagues working
with the same language pair.
So, how do you go about specialising when you do
not have a specialist field to start with? How do you
choose your specialism and find your niche? These
questions and more were addressed by an illustrious
panel of experienced ITI speakers including Sue
Young, Gillian Hargreaves, Rannheid Sharma and
Cate Avery. They each first gave a short presentation
on specialisation, setting out their approach to the
issue and explaining how they came to specialise in
certain areas. They all work in different fields and
have followed different career paths, so this
provided a varied and useful introduction to the
subject.
The floor was then thrown open for questions,
making this a very interactive and lively event.
Members had come prepared with a range of
questions to ask the speakers, leading to an
interesting debate on how to go about choosing a
specialism, which specialisms might be most useful
and lucrative, how to market your specialism and
how to go about training in it. The speakers had
many useful training ideas to help with
specialisation: attending ITI events, completing a
course or module at a university such as
Westminster, engaging in home study, e.g. with the
Open University, becoming an active member of an
ITI language or subject network, and attending
conferences, trade fairs or events related to your
chosen field.
Overall, this was an extremely useful event that
certainly motivated me to focus more on my
specialisation plan. It was also very lively with lots
of audience participation, leading to a pleasant
atmosphere.
Rosemary Black
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Visit to Eltham Palace – 5 May 2009
A group of 20 or so translators and a few friends
and spouses met on a warmish May afternoon at the
gate of Eltham Palace in south-east London. After a
prolonged entrance procedure spearheaded by
excursion organiser Bob Symonds, we went in
through what had been the servants’ quarters, and
donned blue plastic shoe-bags. Many took audio
guides.
All that’s left of the original mediaeval palace
complex is the great hall, the bridge over the moat
and substantial portions of the outer wall. Part of
the ancient enclosure, still surrounded on three sides
by water, is now occupied by a 20th century house
which abuts onto one end of the immensely
impressive gothic great hall.
From the time it was built in the early 1930s until
1944, the modern Eltham Palace was the home of
Stephen and Virginia Courtauld (of the famous
textile family), who required a luxurious family
home that was totally up-to-date and had all the
mod cons that the technology of the time could
afford, from a centralised system of built-in suction
ducts to help the maids hoover the rooms, to piped
music throughout the reception areas. Even the
needs of the family’s pet lemur were catered for. But
whatever your interest in interior design, you
cannot fail to be entranced by the superb art deco
ceilings, wood panelling, fireplaces, mirrors, lighting
and numerous other details including a certain
amount of furniture, some original or built-in to the
house, but most brought in from outside.

LRG News
LRG grants awarded for the ITI
Conference
Earlier in the year, LRG offered two £100 grants to
members, as a contribution to the cost of attending
the ITI Conference in London in May. These grants
have now been awarded to Beata Kazmierczak and
Rhona Desmond.
Rhona will be giving a talk about the Conference on
23rd June and Beata will be writing an article about
it for the next issue of this Newsletter.

Calling all LRG members!
Would you like to get more involved in helping to
run the LRG? The group is currently looking for a
new Chairman (or two new Joint Chairs) to take
over from Betti Moser and Pamela Mayorcas from
the end of 2009.
If you think that you might be interested, just get in
touch with a member of the LRG Committee
(contact details on the back page) or speak to Betti
or Pamela at one of our events.

LRG members (some with their partners) at the Eltham Palace
visit organised by Bob Symonds.

Visitors have access to all the elegant parts of the
house, including bedrooms and en suite bathrooms.
But the high point of the visit is the 14th century
great hall with its amazing hammer-beamed roof.
Lovingly restored by Courtauld (it had previously
been used as a cowshed) and decorated as he
thought it would have looked in mediaeval times,
one has no difficulty in imagining the gargantuan
feasts that would have been organised there in the
time of King Henry VIII, a frequent visitor, and
replicated in the glittering Courtauld years with the
added comfort of underfloor heating.
Afterwards we regrouped for cream tea in the
former kitchen, followed by a walk round the
unusual garden, which makes excellent use of the
moat and offers charming views from terraces at the
top of the old palace walls. Thanks to Bob for
getting that organised!
Nicolas Chadwick

LRG online database survey
LRG conducted an online survey of members in
March to see whether there is demand for an online
directory to replace the printed directory, which is
produced every two years. Specifically, the survey
asked: “Would you be in favour of LRG having an
online searchable database to replace the printed
directory? The online database would only show
FITIs/MITIs for non-LRG visitors to the website and
details of all LRG members for members logging in
to the members’ area of the website.”
Fifty-six people responded. There were 55 ‘Yes’
votes and only one ‘No’ vote – a fairly conclusive
answer! Watch this space for updates on how the
searchable database is progressing.

New LRG members
We welcome the following new members who
have joined the LRG since February:
Alicja Furmanczyk, Eve Miers, Victor Prokofiev and
Hannah Rayner.
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ITI News and Events
ITI Conference 2009:
“Sustainability in Translation”
Saturday and Sunday, 16 & 17 May 2009

For further details, please visit the ITI website –
www.iti.org.uk – or contact the ITI office:
development@iti.org.uk.

Venue: Institution of Mechanical Engineers,
One Birdcage Walk, London SW1

EU terminology and other EU
reference material

The 2009 ITI International Conference is nearly upon
us. We hope to see LRG members turn out in force
for this event, not least because it is being billed as
the ‘must-attend’ event of the year for all translators
and interpreters.

Thursday, 18 June 2009
1.30 to 5.00pm

The programme includes talks from speakers who
use translation and interpreting services in their
work on green issues, as well as sessions on
sustaining the professional translator and interpreter, sustaining the profession and moving with
the times. It provides sessions to suit all interests
and levels, from those considering a career in
translation and interpreting through to wellseasoned experts.
The gala dinner on the Saturday evening takes place
in the Library of the Institution of Mechanical
Engineers. After-dinner speaker is the well-known
former BBC weatherman, Bill Giles OBE, who is
very knowledgeable about green issues and
sustainability and has had direct experience of
working with translators and interpreters over the
course of his long and illustrious career. He has
maintained strong links with the worlds of
meteorology and broadcasting since his retirement
and will provide diners with entertaining yet
thought-provoking insights into meteorology,
broadcasting and climate change.

Venue: London European Commission Office,
8 Storey’s Gate, London SW1P 3AT
(nearest underground: Westminster or St
James’s Park)
A follow-up to the highly successful workshops held
in 2006 and 2007 in London and Birmingham, this
event will give participants another opportunity to
discover the benefits of IATE - the publiclyaccessible online terminology database developed
by the EU Institutions and of EUR-Lex, the online
database of EU legislation.
The speakers are:
• Timothy Cooper, Senior Terminologist in the
English Language Department of the DirectorateGeneral for Translation (DGT) at the Commission
in Brussels.
• Professor Margaret Rogers of the University of
Surrey, founder of the Association for
Terminology and Lexicography. Margaret is wellknown to ITI members as an expert on the
importance and relevance of terminology to
translators.

The full programme is available on the conference website:
www.iti-conference.org.uk

The event will be chaired by Fiona Harris, DGT’s
Language Officer at the London Field Office of the
Commission.

Starting work as a translator or
interpreter

There will also be an introduction to the English
Style Guide of the Commission’s Translation Service,
an invaluable document that covers not only English
style but also important information about the EU.

Saturday, 6 June 2009
10.00am to 5.00pm
Venue: University of Westminster, 309 Regent
Street, London W1B 2UW
This joint ITI/University of Westminster all-day
event is being organised with the support of Routes
into Languages and the National Networks for
Translation and for Interpreting. There will be talks
by trainers and practitioners on the qualities and
skills needed for working as a translator or interpreter. Speakers include Paul Appleyard, Sarah
Griffin-Mason, Philippe Galinier and Stella Cragies.
Participants will learn how to get started, organise
and develop their careers, and tailor their skills to
meet market demands.

Almost all translators and interpreters come into
contact with EU terminology and reference material
at some stage in their professional life and this is a
unique opportunity to familiarise oneself with the
online support material available and discuss
problems with experts.
The workshop has been generously sponsored by
the European Commission’s DGT and is being held
at the EU Representation’s offices in London.
Registration fee, to include lunch, refreshments,
documentation and handouts: £25 for ITI members, £35
for non-ITI-members (both prices include VAT).
To register, please go to www.iti.org.uk – ITI Events – ITI
and download a booking form.
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Getting the most out of spreadsheets
LRG Treasurer Oliver Walter shares some ideas on how to use Excel spreadsheets for more than just
number-crunching.
I have recently spoken to translators who told me
they were unaware of the uses of a spreadsheet for
purposes that are not “numbers and formulae”. This
article is about some of those other ways a
spreadsheet program like Microsoft’s Excel can be
used. I shall show you:
• how Excel can be used for recording work – both
the time spent and the speeds achieved;
• how it can be useful in managing multilingual
glossaries; and
• how it can be used to maintain lists of links to
files and websites.

Work times and speeds
Figure 1 is the top part of a demonstration
spreadsheet that illustrates the principles I use in
recording times and speeds. There are two keyboard
shortcuts that make timekeeping easy once you have
started the spreadsheet: Ctrl+; (i.e. Control and
semicolon) and Ctrl+: (Control and colon). For a
spreadsheet like this, start by clicking cell A1 to
select it, type the text (“Job 123: Demonstration”),
press the Enter key to complete the cell entry, and
then select the required font (in this case Arial 12point bold). For this you can use the formatting
toolbar or Format > Cells > Font, either from the
menus or from the pop-up menu when you rightclick the cell. Cells A2 to E2 were similar except that
after typing the text in each of these, I simply
pressed Ctrl+B on the keyboard (shortcut for bold)
as I didn’t want to change the font size from the
default 10-point.
Then, in cell A3, typing Ctrl+; made today’s date
appear. To record the start of the first work session,

Figure 1: Demonstration spreadsheet

click cell B3 to select it, type Ctrl+: and the current
time appears, in this case 15:56. At the end of the
work session, typing Ctrl+: in cell C3 makes the new
current time appear, in this case 16:30.
To show the duration (the end time minus the start
time), select Cell D3 and enter the required formula
which is:
=C3-B3
To do that, either type all 6 characters (in this case)
of the formula or, for yet more short cuts, first type
the “=”, then click on cell C3, which will enter its
reference (C3) in the formula, then type the “-”, then
click B3, and end with the Enter key. If the result
isn’t in the expected time format, (e.g. it is 0.02
instead of 00:34), use Format > Cells > Number
(menu or right-click as above) and select “time”
from the list, or “custom” and type hh:mm as your
custom format. Note that if a session begins before
midnight and ends after midnight, this doesn’t give
the correct value.
For the second and other sessions, you can use the
shortcuts again to enter the date and start and end
times. For the session durations, you don’t need to
type a formula again into column D; Excel can do it
for you and adjust the cell references automatically.
To do this, either:
(a)copy Cell D3 (Ctrl+C or right-click and Copy)
and then paste into D4 (Ctrl+V or right-click and
Paste) or;
(b)“fill down” from D3 to D4: click on D3, position
the mouse pointer on the lower right corner of
the cell (it changes shape) and drag down to the
next cell (D4) or select both cells (click the centre
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of one, drag to the other) and press Ctrl+D or use
Edit > Fill > Down.
All of these will give the formula =C4-B4 in cell D4.
Note that you can’t do this by typing Ctrl+’ (which
means “copy the cell above”) in D4 as that will copy
D3 into D4 without adjusting the cell references.
When I do my timekeeping, I want to know the total
time I’ve spent on this job, not just one session, and
that is done in column E. The first entry (in E3) is
different from the ones below it because, after the
first session, the total time is obviously only the time
of that session. Therefore cell E3 is equal to D3. No,
not quite, because I want the number of hours in E3
but the values in D3, C3 and B3 are all in units of
days (so that midday, for example is actually stored
as 0.5, but the format hh:mm shows it as 12:00).
Therefore E3 contains the formula =D3*24, as you
see in the formula bar in Fig. 1, since E3 is the
selected cell. (In case you didn’t know, the asterisk
“*” is usually used in computer contexts instead of
the letter x to indicate multiplication.)
For each of the other Total cells in column E, the
formula adds the duration of the current session to
the total of the previous sessions. Therefore, the
formula in E4 is =D4*24+E3. D4 is this session’s
length in days and E3 is the preceding total in
hours, so D4 is multiplied by 24 as was D3 previously. The session date, start, end and durations
are entered into row 4 in the same way as was done
in row 3. If I have more than 2 sessions on a job, I
use “fill down” or copying with automatic adjustment of the cell references as I did in column D. This
gives the formula =D5*24+E4 in cell E5. You can see
these formulae and what the spreadsheet “really”
contains in Figure 2.
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the same format and leave columns B and C blank
in that row. In this example, if I had done that in
row 5, cells B5 and C5 would be empty and D5
would contain 00:34 instead of =C5-B5. Then to
resume the use of formulae in row 6, I would copy
(Ctrl+C and Ctrl+V) D4 into D6, where the formula
would become =C6-B6.
For calculating your speed of working, look at the
formulas view in Fig. 3: the important point to
remember is that your speed in words per hour is
W/H (W divided by H) if you spent H hours in

Figure 3: Formulae and numbers for speeds
translating a number W of words. In the example,
I’ve included more calculations than you would
probably want in practice. Each non-empty cell
contains either a number that I typed (from using
Tools > Word Count to count the words in selected
text) or a formula. You can see that I haven’t been
consistent in entering numbers and formulae, but
they all give the right answers (or nothing) as you
can see in Figure 1. ST stands for Source Text and TT
for Target Text. The “Avge rate TT” is the total of TT
words so far (column I) divided by the total time so
far (column E). “Incr rate” is the incremental rate,
which is the number of words per hour of the
session recorded in that row. Note the division by 24
because column D is in days, not hours.

Multilingual glossaries
A spreadsheet can be a handy way to create and
manage multilingual glossaries.
1. Both spreadsheets and glossaries naturally take
the form of tables.
Figure 2: “True” contents of some cells
This is part of the same spreadsheet, but I used the
keyboard shortcut Ctrl+` to switch the window to
formulas mode. (This is with the “grave”
apostrophe above the Tab key, not the usual one
under the “@” symbol.) Quiz question: can you
work out what the numbers are in column A?
It may sometimes be necessary to “cheat” by typing
times directly into columns B, C or D. If you started
a session at 9.30 but forgot to record this, just type
09:30 into the cell in column B. If you know how
long you spent on something but not the start and
end times, just type the duration in column D using

2. It is fairly easy to copy tabulated glossary data
from PDF files into a spreadsheet.
3. A spreadsheet can sort rows of data so that any
required column is in alphabetical order.
4. A spreadsheet glossary can easily be imported
from, or exported to, a pure text file. This can be
useful if, for example, you want to edit it with a
text editor, give it to somebody who can’t open
Excel files, or use it with a translation tool that
can work with text file glossaries but not Excel
files.
5. It can easily extract a bilingual glossary from a
sheet containing columns for more than two
languages.
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Extracting tables from PDF files
Copying tables of terminology from a PDF
document requires the document to be of the type
that contains “real” (selectable) text, not a scanned
image (for which you can probably use an OCR
program). This is done using the “column select”
tool of the Acrobat Reader, to select a single column
at a time, and then copy it and paste into the
spreadsheet. In earlier versions (including 5) of the
Reader, the column select tool is turned on or off
with “V” on the keyboard or in the drop-down
menu of the text-select icon in the toolbar. In later
versions (6 and 7) it is more automated: the I-beam
pointer changes to the column select pointer (which
has a dotted box superimposed on the I, like
this:
) when you move the arrow pointer to a
suitable point to the left of the column of text. In
version 8 (and perhaps 9 – I haven’t used it), you
activate the text-select tool (next to the hand tool in
the toolbar) and press the Alt key while the cursor is
near the text.
In all these cases, to select a column of text you use
the left mouse button to drag a selection rectangle
over the text and then release the button. This is
illustrated in Figure 4. The column select pointer
should be shown at the lower right corner of the
selection rectangle, but the screen-capture in
Windows (the Print Scrn key on the keyboard) never
includes the mouse pointer. Having made a
selection like this (usually, of course, all the rows of
that column visible on the page), copy it to the
Clipboard (Ctrl+C), go to the first Excel cell where
you want to copy it, and paste it there (Ctrl+V).
Then return to the PDF file and do the same for the
corresponding entries in the next column.

Figure 4: Using the column-select tool on a PDF document

Converting between Excel files and text files
When you have a glossary in an Excel file, it’s easy
to save it as a text file. First, make sure the spreadsheet is open and displaying the sheet you want to
save. Then choose “Save as...” from the File menu.
In the “Save as type” list, select “Text (Tab
delimited)(*.txt)”. When you click Save, you will
probably be given two warnings: one says that you
can only save one worksheet and the other is about
“features that are not compatible with text”. In each
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case, click “OK” or “Yes” because that’s what you
want, and the original spreadsheet (which you did
save first, didn’t you?) is not lost by doing this. The
resulting text file has the text from the cells of the
spreadsheet, with the text in successive columns
separated by Tab characters. If there is a comma in
the text in a spreadsheet cell, the text of that cell will
be enclosed in quotes in the text file.
For the reverse process (opening a tab-separated text
file in Excel so you can save it as a spreadsheet) you
can either drag the file from Windows Explorer to
the Excel icon on your desktop (if you have such an
icon there) or start Excel and use File > Open to find
the file. If you drag it to the icon, the file will open
immediately, using the Tab characters as column
separators. If you use Open within Excel, you need
to use the list “Files of type” to specify “Text files”
(or “all files”) and then you will see the “Text
Import Wizard” where the defaults will be correct
(Delimited, Tab, General). To save this spreadsheet
as an Excel file, you need to specify the file type in
“Save as...”.

Links to your files and websites
Another thing you can do with Excel is use it to
make lists of links to files (e.g. glossary files on your
own PC’s disk) and web pages. This is done by
putting hyperlinks into cells and then the file or web
page is opened when you click on the hyperlink.
This can be like a set of “favorites” in Internet
Explorer or “bookmarks” in Firefox, but the
differences may be useful: a hyperlink to a Web
page will open with the default browser, so you can
copy such a spreadsheet to a computer that uses a
different browser and the pages will still open. You
can add extra columns to
show, for example, the
relevant languages, your
description of the target,
the date you checked the
validity of the link, the
number of entries if it’s a
glossary etc.
Excel has its own “create
hyperlink” facility: right
click on the cell where you
want it, and select
“Hyperlink...” from the
pop-up menu. If the cell already contains a hyperlink, you get a submenu that includes edit and
delete options. I now usually make hyperlinks a
different way as it seems simpler and more
understandable to me: the function HYPERLINK.
Examples: to use this to create a hyperlink to a file
called MyGlossDeEn.txt, located in folder
E:\Translation\ and have “My DeEn glossary”
displayed in the cell, you could enter the following
as the cell contents:
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=HYPERLINK(“E:\Translation\MyGlossDeEn.txt”,
“My DeEn Glossary”)
You could make hyperlinks to the UK, German and
French Google like this:
=HYPERLINK(“http://www.google.co.uk”, “UK
Google”)
=HYPERLINK(“http://www.google.de”, “German
Google”)
=HYPERLINK(“http://www.google.fr”, “French
Google”)
A very small spreadsheet containing these links
might look like Figure 5.

Figure 5: Example of hyperlinks
I hope this article has given you some useful
information and that it may perhaps stimulate you
to find out more about how spreadsheets can help
you.
Oliver Walter

Noticeboard
Useful websites

For a giggle...

Have you ever wondered about other alphabets and
writing systems, needed tips on learning new
foreign languages, wanted to find useful phrases in
a wide range of languages, hankered after some
language-related articles, or just wanted to try your
hand at some language puzzles? Then Omniglot at
www.omniglot.com is the site for you. It has all of
these things and more. Why not take a look?

A disappointed salesman of Coca Cola returns from
his Middle East assignment. A friend asked, “Why
weren’t you successful with the Arabs?”

Diary dates

First poster: a man lying in the hot desert sand...
totally exhausted and fainting.

THIRD THURSDAY MEETINGS
AT THE NORFOLK ARMS:
21 May, 18 June, 16 July from 6.00pm

Second poster: the man is drinking Coca Cola.

For those of you not on the LRG e-group, this is an
informal monthly translators’ gathering, organised
by Sophie Leighton and Andrea Reinacher and
advertised on the LRG e-group and the equivalent
forum of the CIoL London Group.
The Norfolk Arms is a gastro-pub offering a very
nice selection of tapas amongst other things.
For details of the pub and a map, see
www.norfolkarms.co.uk.
To find the group, look out for the ITI Bulletin on the
table!

The salesman explains:
“When I got posted in the Middle East, I was very
confident that I would make a good sales pitch as
Coca Cola is virtually unknown there. But, I had a
problem – I didn’t speak Arabic. So, I planned to
convey the message through three posters...

Third poster: our man is now totally refreshed.
And then these posters were pasted all over the
place.”
“Then that should have worked!” says the friend.
“The hell it should have”, says the salesman, “didn’t
realise that Arabs read from right to left!”
Many thanks to Andrea Reinacher for sharing this.
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LRG events programme for 2009
Friday, 15 May
from 6.30pm

ITI Networks & Regional Groups pre-Conference gathering

Tuesday, 23 June
6.30 for 7.00pm

Report from the ITI Conference

At The Old Star, 66 Broadway, London SW1H 0DB (opposite St James’s
Park tube station).
To book a place at the LRG table, please contact Anna George at
anna@agtrans.co.uk.

Rhona Desmond, one of the recipients of the LRG conference grant, will
give a talk summarising her experience of the ITI Conference.
At The Devereux, 20 Devereux Court, off Essex Street/Strand, London WC2
To book, please contact Fiona Franks at ffranks01@googlemail.com.

Thursday, 16 July
from 6.00pm

The annual LRG Pub Crawl
Pubs in Belgravia. Details to be announced by email.
For details please contact Julia ten Elsen at j_tenelsen@yahoo.com.

Saturday, 12 September
10.30am – 4.30pm

Marketing Workshop
A day of talks and hands-on workshops on all aspects of marketing
yourself as a freelance translator and interpreter.
Cost: £25 for LRG members, £35 for non-LRG. To book, please contact Fiona
Franks at ffranks01@googlemail.com.

October

Dining-out evening
Contact: Lorna Sandler at adept.Lrs@btinternet.com

November

Court interpreters’ workshop
Contact: Lorna Sandler at adept.Lrs@btinternet.com

See www.iti-lrg.org.uk for the latest updates on forthcoming events.

Committee Contacts
Joint Chair

Betti Moser

betti@apriltext.co.uk

Joint Chair, ITI liaison

Pamela Mayorcas

pmayorcas@googlemail.com

Membership Secretary

Daniela Ford

dford@softrans-ltd.com

Treasurer

Oliver Walter

translator@owalter.co.uk

Newsletter Editor

Rosemary Black

translations@rosemaryblack.co.uk

Website Manager and
E-group Moderator

Peter Linton

peter@lintononline.co.uk

Events Secretary

Fiona Franks

ffranks01@googlemail.com

Publications

Julia ten Elsen

j_tenelsen@yahoo.com

Interpreters’ Representative

Lorna Sandler

adept.Lrs@btinternet.com

